Song Exposure affects HVC Ultrastructure in Juvenile Zebra Finches

Houda G Khaled
Advisor: Dr. Sharon M.H. Gobes
Department of Neuroscience

Submitted in Partial Fulfillment
of the
Prerequisite for Honors
in Biochemistry

May 2016

© 2016 Houda Khaled
# Table of Contents

ABSTRACT ................................................................................................................................. 2

ACKNOWLEDGEMENTS .............................................................................................................. 3

INTRODUCTION .......................................................................................................................... 4

I. SYNAPTIC PLASTICITY IN LEARNING AND MEMORY .......................................................... 4
   Basic principles of synapse structure ..................................................................................... 4
   Changes in synapse number, size and shape .......................................................................... 6

II. SONG ACQUISITION AS A LEARNING PARADIGM ............................................................ 7
   The song system ...................................................................................................................... 9
   Structural synaptic plasticity in the song system ..................................................................... 11

III. FOCUSED ION BEAM SCANNING ELECTRON MICROSCOPY (FIB-SEM) ......................... 12

MATERIALS AND METHODS ..................................................................................................... 15

I. SUBJECTS .................................................................................................................................. 15
   Electron Microscopy Studies ................................................................................................. 15
   Protein Expression Studies ........................................................................................................ 15
   Tutoring Paradigm .................................................................................................................... 15

II. ELECTRON MICROSCOPY ..................................................................................................... 16

III. IMMUNOHISTOCHEMISTRY ................................................................................................. 18

IV. IMAGE ANALYSIS ................................................................................................................ 20
   Synapse Count & Size ............................................................................................................... 20
   Synapse Curvature ................................................................................................................... 22
   Protein Expression ................................................................................................................... 22

V. STATISTICAL ANALYSIS ......................................................................................................... 23

RESULTS ...................................................................................................................................... 24

I. SYNAPSE SIZE AND CURVATURE ......................................................................................... 24
   Synapse Size ............................................................................................................................ 25
   Synapse Curvature .................................................................................................................... 27

II. PROTEIN EXPRESSION .......................................................................................................... 28

APPENDIX .................................................................................................................................... 35

CITED WORKS ........................................................................................................................... 65
Abstract

Zebra finch song learning bears many similarities to human language learning, and thus the zebra finch is a useful model for understanding the biological processes involved in vocal skill acquisition. Song exposure in juvenile zebra finches triggers rapid spine enlargement and spine stabilization in HVC, an important brain area for adult song production (Roberts et al., 2012; Roberts et al., 2010). However, it is currently unknown whether in conjunction with learning-related spine changes there are also associated changes in synaptic structure and morphology. We paired juvenile male zebra finches with an adult bird (tutor) for various durations of time during the song-learning period. Birds were sacrificed at 59 days post-hatch and tissue from HVC was collected. Samples were processed for electron microscopy and imaged using a focus ion beam scanning electron microscope (FIB-SEM). Synapses in HVC were manually identified, and classified by subtype (symmetric or asymmetric) and shape (convex, concave, flat or irregular). All identified synapses were segmented in 3D using ilastik, an interactive machine learning tool for image processing. Degrees of synapse curvature were quantified using EspINA, which enables measurement of synapse morphometric features. Comparisons of HVC synapse volumes, diameters, and curvatures were made among experimental groups that varied in their experience with tutor song. Immunohistochemical detection of excitatory and inhibitory scaffolding proteins PSD-95 and gephyrin, respectively, was used to confirm changes in synapse size. We found that asymmetric synapse volumes are significantly larger in bird groups exposed to song as compared to song isolates. Transient increases in synapse diameter and in synapse curvature emerged rapidly following tutor song exposure: the convexity difference between symmetric and asymmetric synapses significantly increased after one day of tutoring and decayed back to pre-tutoring levels within 3 weeks of first exposure. Preliminary immunohistochemical experiments suggest an increase in gephyrin protein expression following tutor song exposure. Overall, our results suggest that synapse morphology in the zebra finch HVC depends on tutor song exposure.
Acknowledgements

I would first like to thank my advisor, Professor Sharon Gobes, for giving me the opportunity to work on this project, and for her ongoing support and guidance.

Thank you to the members of my thesis committee, Professors Megan Nunez and Drew Webb, for their valuable insight throughout this process.

To the Gobes lab, especially Shivani Dayal, Leila Elabbady, Rie Maeda, Julia Lord, Alexa Pagliaro, and Rebecca Jennings, thank you for your supporting contributions, inspiration, and constant enthusiasm. And congratulations to my fellow seniors Leila, Rie, and Stela Petkova for all of their hard work!

I would also like to thank the Hahnloser lab, and Ziqiang Huang in particular, for welcoming me to their lab during my stay in Zurich and for sharing their expertise.

Many thanks to Pat Carey and Val LePage for their excellent care of the finches, and to Casey Pattanayuk for her statistics advice.

Thank you to my friends for their patience and moral support: Beba Cibralic, Eloisa Cleveland, Anat Mano, Natalie Oppenheimer, Shweta Patwardan, Jordan Sessa, Helen Walsh, Zhou Wang, and the members of Al-Muslimat.

Finally, thank you to my parents, Ghassan Khaled and Mai Sidawi, and to my brothers, Yousuf and Faisal Khaled, for their unconditional love and encouragement.

This thesis was generously funded by the Susan Todd Horton Class of 1910 Trust Summer Research Fellowship, the Hubel Neuroscience Summer Research Fellowship, and the Seven College Conference of London Junior Year Abroad Award.
Introduction

I. Synaptic plasticity in learning and memory

The question of how memories are formed and represented in the brain, and consequently how learning occurs, has puzzled scientists for centuries: it was not until the 20th century that the presence of a physical (as opposed to psychic) basis of memory was resolved (reviewed by: Tonegawa et al., 2015). This perspective was strongly argued by Richard Semon, who first coined the term ‘engram’ to describe a “primarily latent modification in the irritable substance produced by a stimulus” (1921). Support for this idea came from brain lesion studies, which led to memory deficits, and experiments in which regions of the brain were stimulated with small amounts of electricity, which sometimes led to recall of random episodic memories (Alonso-Nanclares et al., 2013).

While Semon did not elaborate upon what modifications might be occurring after a ‘stimulus’ to form a memory of that experience, or how those modifications might arise, significant progress on this front came in the form of Hebbian theory, developed by Donald O. Hebb in The organization of behavior (1949). In this work, Hebb describes a model for how a repeated experience may result in the formation of a ‘memory trace’ or ‘engram’: “When an axon of cell A is near enough to excite a cell B and repeatedly or persistently takes part in firing it, some growth process or metabolic change takes place in one or both cells, such that A’s efficiency, as one of the cells firing B, is increased.” Hebb went further to theorize that these changes in efficacy may be occurring through structural changes at the synapse, either by increases in the number of synapses, or by increases in the size of pre-existing ones (reviewed by: Cooper, 2005).

Basic principles of synapse structure

Investigation of synapse morphology and its relation to function is necessary for an understanding of how changes in those qualities relate to learning and memory formation.
Generally, synapses are defined as having a pre-synaptic component, containing vesicles for transmission across the synapse, and a post-synaptic component, consisting of the length of the membrane contacting the pre-synaptic membrane (apposition zone) and the synaptic cleft (van der Zee, 2015). Early work by Edward Gray led to categorization of synapses based on their morphologies: Type I, or asymmetric, synapses were found on dendritic spines and shafts, had thicker post-synaptic densities (PSDs), and round vesicles in the pre-synaptic bouton. Type II, or symmetric, synapses, were found on dendritic shafts and neuronal cell bodies, lacked thickened PSDs, and had more flattened vesicles (Gray, 1959; Figure 1). These were later found to be excitatory glutamatergic and inhibitory GABAergic synapses, respectively (Harris and Weinberg, 2012; van der Zee, 2015).

The PSD of a synapse is exceptionally complex, consisting of hundreds of different proteins in order to enable synaptic signaling and stabilize the synapse. The structure and composition of excitatory and inhibitory PSDs differ widely in molecular composition and organization, enabling their functional specializations (reviewed by: Collins et al., 2006; Sheng and Kim, 2011). These include postsynaptic scaffolding proteins, which bind to membrane proteins and signaling molecules in the PSD, stabilizing the synapse. A large number of scaffolding proteins have been identified, including several that are specific to either excitatory or inhibitory synapses. Of those characterized, PSD-95 (also known as SAP90) has been found to localize exclusively in excitatory synapses, while gephyrin is specific to inhibitory synapses (reviewed by: Kim and Sheng, 2004; Kneussel and Betz, 2000).

Within these categories, synapses vary individually by number of vesicles, PSD thickness and length, dendritic spine size and shape, curvature, and molecular composition. These features have been shown to vary by neuron type, and to be dynamic: synapses and spines may change in size and shape over time (reviewed by: Harris and Weinberg, 2012). The molecular composition of a synapse has been connected with its morphology, so that levels of synaptic scaffolding proteins PSD-95 (Cane et al., 2014; Meyer et al., 2014) and gephyrin (Yu and De Blas, 2008)
protein expression have been shown to correlate with synapse size. Some morphological characteristics have also been linked to levels of learning and experience, and have furthermore been shown to have functional consequences. In particular, size of the post-synaptic density has been correlated to increased signaling strength and stability of a synapse (Magee and Cook, 2000).

![Figure 1: Examples of symmetric (red arrows) and asymmetric (green asterisks) synapses.](image)

Symmetric synapses are characterized by thin post-synaptic densities and round vesicles, while asymmetric synapses show more prominent post-synaptic densities and flattened vesicles.

**Changes in synapse number, size and shape**

Study of structural synaptic plasticity associated with learning has led to somewhat conflicting results depending on the brain region studied, and the learning paradigm used. Some evidence suggests that changes in synapse density are correlated with learning (reviewed by: Leuner and Shors, 2004; Moser et al., 1994; Xu et al., 2009) although data supporting the opposite or no change have also been reported (Bednarek and Caroni, 2011; O'Malley et al., 1998; Popov et al., 2004; Sorra and Harris, 1998; Stewart et al., 2005). Experience-dependent morphological changes in synapses have been reported in the rat hippocampus after spatial learning (Rusakov et al., 1997). Spatially trained rats showed an increase in the frequency of shorter distances (clustering) between synapses in CA1, suggesting local re-arrangement of synaptic connections, while studies of the rabbit visual cortex have revealed increased thickness
of postsynaptic densities and increased frequency of perforated synapses after visual training (Vrensen and Cardozo, 1981). Data supporting an association between synapse curvature and learning have also been published. Following induction of long-term potentiation, a model for learning, decreased degree of concavity and increased convexity was observed in the rat dentate gyrus (Medvedev et al., 2010).

Other data have noted changes in synaptic subtypes associated with learning. A study in the rabbit interpositus nucleus found no changes in synapse shape, but instead found increased length specific to concave synapses after eye-blink conditioning (Weeks et al., 2007). Weeks et al. also noted increases in length were specific to asymmetric excitatory synapses. Similar results have been reported in the chick hyperstriatum ventral (IMHV) (Horn et al., 1985), where an increase in post synaptic density length was observed in spine, but not shaft, synapses. Spine and shaft synapses are predominantly excitatory and inhibitory synapses, respectively. Together, these results suggest that the excitatory and inhibitory systems may be differentially involved in learning and memory acquisition.

II. **Song acquisition as a learning paradigm**

One powerful model system for learning is the songbird, particularly the zebra finch (*Taeniopygia guttata*). Zebra finches are commonly used model organisms for study of the neurobiological basis of vocal learning, mainly due to the marked similarities between zebra finch song and human speech acquisition: For one, both humans and zebra finches share the uncommon trait of vocal learning (Doupe and Kuhl, 1999). While most animal species have innate communicative signals, and thus do not need to be exposed to vocalizations of their own species in order to reproduce them, this is not the case for both humans and zebra finches. Instead, both of these species must be exposed to the vocalizations of an adult in order to produce typical species-specific vocalizations. In zebra finches, only males produce song, requiring exposure to an adult male “tutor” to produce typical wild-type song (Williams et al., 1993). Both species also
have innate predispositions to the vocal behavior of their own species: zebra finches have a preference to songs produced by other zebra finches over heterospecific songs, even in complete isolation from conspecific song (Braaten and Reynolds, 1999). This model in which both innate predisposition and specific experience are involved in vocal learning has thus been termed “template-guided learning,” with the template representing an internal representation of the learned song or speech (reviewed in: Bolhuis and Moorman, 2015).

**Figure 2: Song acquisition in zebra finches.** (a) Timeline of song learning (b) Spectrograms displaying songs at different stages of song development (Adapted from Garst-Orozco et al., 2014).

The process of template-guided learning in both humans and zebra finches occurs during a “critical” (sensitive) period, when the infant or juvenile bird is most receptive to vocal learning. In zebra finches, two overlapping phases of learning occur during this period: the memorization phase (~20-65 days posthatch; dph), in which the juvenile stores auditory-vocal information from the male tutor song, and the sensorimotor phase (~35-90 dph), in which the bird matches its own vocal output with the stored information to produce an imitation of the tutor song (Bolhuis and Moorman, 2015). During this process, zebra finches go through two major stages of song development beginning with a “babbling”-like stage at less than 45 dph, in which birds produce “subsong,” consisting of long rambling series of sounds. Vocalizations begin to audibly resemble tutor song around 45 dph, at which point song becomes less variable and develops the basic syllabic structure of birdsong, termed “plastic song.” After ~90 dph, the song “crystallizes” into full song, with highly stereotyped syllables, and exact timing and sequencing of syllable production. This song remains relatively unchanged throughout the rest of the individual bird’s
lifetime (Konishi, 1985). The end result is an imitation of the tutor song, so that the extent to which the crystallized song resembles the tutor song can be considered a measure of learning.

**The song system**

Specific regions within the songbird brain have been shown to be involved in song learning, perception, and production. These include two major interconnected neural networks: the anterior forebrain pathway (AFP), the song motor pathway (SMP) (together called the “song system”), as well as the secondary auditory regions (Figure 3). The AFP originates in HVC (proper name) and passes through Area X, the thalamic nucleus dorsolateralis anterior, pars medialis (DLM), the lateral magnocellular nucleus of the anterior nidopallium (LMAN), and the robust nucleus of the arcopallium (RA) of the SMP to form an anterior cortical – basal ganglia – thalamic loop. The SMP connects HVC with RA and the tracheosyringeal portion of the nucleus hypoglossus (nXllts). The secondary auditory regions include the caudomedial nidopallium (NCM) and caudomedial mesopallium (CMM) (reviewed by: Bolhuis and Moorman, 2015).

![Figure 3: Schematic of the zebra finch song system](image)

Regions involved in song learning are highlighted, including HVC, which is involved in both the anterior forebrain and song motor pathways (Adapted from Mooney, 2009)
The roles of each of these regions in zebra finch song learning and production have been extensively researched through lesioning experiments (ex. Bottjer et al., 1984; Scharff and Nottebohm, 1991; Sohrabji et al., 1990), and pharmacological inhibition (ex. Aamodt et al., 1996; Gobes and Bolhuis, 2008; London and Clayton, 2008). Measurements of activation of regions in response to specific stimuli (ex. Mello et al., 1992; Solis et al., 2000; Terpstra et al., 2004) have also aided in the identification of the function of these regions. One key nucleus is HVC, which is included in both the AFP and SMP. HVC acts as a sensorimotor interface, receiving sensory information through direct input from higher-order auditory centers (Bauer et al., 2008), and driving motor neurons in the brainstem via projections to RA (Long and Fee, 2008). In juvenile zebra finches, HVC has been suggested to play an important role in song learning. HVC neurons are tutor-selective in awake juvenile zebra finches during the early sensorimotor phase, a preference which switches to the bird’s own song later in development (Nick and Konishi, 2005), including during singing (Jarvis and Nottebohm, 1997; Kimpo and Doupe, 1997). This would suggest that HVC contains a transient representation of tutor song in the early stages of song learning. Disruption of HVC during tutoring also results in failure to imitate the tutor (Roberts et al., 2012), supporting HVC as an important site for song learning.

HVC has been further implicated as a site of auditory-vocal integration within the song system. This integration is necessary for template-guided learning, in which the bird uses feedback from its own singing to modify its vocalizations in order to better match the tutor-song memories. Evidence supporting this hypothesis comes from studies confirming a projection to HVC from CMM, a source of auditory input which is activated both in response to song playback and during singing (Bauer et al., 2008). Individual neurons in HVC which correspond to notes within a bird’s song during singing have been identified, which were active even when auditory feedback was disrupted, further linking HVC to both auditory and vocal activity (Hahnloser et al., 2002; Prather et al., 2008).
**Structural synaptic plasticity in the song system**

A number of studies have shown changes in structure of the song system during song learning (reviewed by: Nordeen and Nordeen, 1997). This includes a dramatic increase in neuron number and volume of Area X (Nordeen and Nordeen, 1988) and HVC (Bottjer et al., 1985; Bottjer et al., 1986; Nordeen and Nordeen, 1988) during song learning, and a decrease in dendritic spine density on LMAN spiny neurons (Nixdorf-Bergweiler et al., 1995), a change which is delayed by song isolation. Volume of RA increases during the same period, as does the total synaptic density (Herrmann and Arnold, 1991) and density of HVC synapses in RA (Konishi and Akutagawa, 1985).

In vivo analysis using two-photon microscopy has been conducted to measure changes in dendritic spine stability and size in zebra finch HVC during song learning (Roberts et al., 2012; Roberts et al., 2010; Figure 4). Results from these studies showed individual variance in dendritic spine turnover (appearance and disappearance of spines over time) in isolate birds. Birds with initially higher levels of turnover were later better able to copy a tutor song, and an overall reduction in turnover was observed after exposure to tutor song. Together, these results suggest that heightened spine dynamics in HVC are important for song learning, and that song exposure stabilizes dendritic spines, a mechanism by which synaptic transmission in HVC may be enhanced. In addition to measuring spine dynamics, the authors measured changes in dendritic spine size, using fluorescent intensity as a proxy for size. Results showed a significant increase in spine size only one day after tutoring. This increase in dendritic spine size was prevented by administration of D-AP5, which acts as an antagonist to NMDA receptors in the synapse, during tutoring sessions. Activation of NMDA receptors D-AP5 treatment also disrupted tutor song imitation in those birds. Thus, changes in spine size may be correlated with song learning in zebra finches.
Figure 4: HVC-spine size is related to tutor song exposure and successful tutor song imitation depends on NMDA receptors (a) An increase in fluorescent intensity of spines was observed in HVC after one day of tutoring. (b) Song similarity scores of birds who received D-APV treatment (green) during tutoring, and controls (black), suggest that NMDA receptor activation is necessary for successful song imitation (Adapted from Roberts et al., 2010).

III. Focused Ion Beam Scanning Electron Microscopy (FIB-SEM)

Electron microscopy is essential for study of the synaptic basis of neural circuits, as it is currently the only available technique which images at a high enough resolution to visualize synapse ultrastructure. It was this technique which first allowed for the characterization of fine synapse structure in the 1950’s (Gray, 1959; Palay and Palade, 1955). Electron microscopy involves the use of an electron beam which is shone onto a sample, previously fixed and incubated in electron dense solutions to increase contrast in typically transparent biological specimens. Based on the electron density of regions within the fixed sample, electrons may pass through the sample, deflect off the surface, or cause secondary electrons to be emitted by the specimen. In transmission electron microscopy (TEM), the electrons which pass through the specimen are detected. Variation between areas of different electron density is conveyed as differences in contrast within the final image: darker areas are more electron dense, and thus fewer electrons are able to pass through, while whiter areas are more permeable to electrons. Instead of a static electron beam, scanning electron microscopy (SEM) produces images by scanning over an area of
a sample with a lower-energy fine point. SEM detects secondary and backscattered electrons, rather than electrons which have penetrated the sample, providing information about the surface of the sample.

Electron microscopy has recently evolved to enable the analysis of 3-dimentional features in neurological samples through the development of ‘volume’ electron microscopy techniques (reviewed by: Peddie and Collinson, 2014). This includes serial section transmission electron microscopy (ssTEM), in which ultrathin serial sections are manually collected and individually imaged. Stereological methods are then used to examine features such as synapse size and shape. Focused Ion Beam Scanning Electron Microscopy (FIB-SEM) is an advanced type of volume electron microscopy which allows one to achieve higher resolution in the z plane. This is accomplished by milling a thin section from the surface of a sample using an ion beam. The precision of the (gallium) ion beam allows for sections to be as thin as 3 nm, much thinner than those obtained by ssTEM and other conventional electron microscopy techniques (Knott et al., 2008). The resulting voxel (3-dimentional pixel) resolution is high enough to generate electron microscopy volumes, so that the three-dimensional characteristics of objects can be visualized and directly investigated. As FIB-SEM is highly automated, image quality it is less dependent on the skill of the operator, often leading to greater preservation of sections and less generation of artifacts.

Figure 5: Focused Ion Beam Scanning Electron Microscopy (FIB-SEM) apparatus. FIB-SEM uses a dual-beam SEM, in which an electron beam images the top layer of a sample, while a focused ion beam precisely mills away the imaged layer to reveal the next layer to be imaged (adapted from: Briggman and Bock, 2012).
While FIB-SEM has been in use for the study of biological samples since at least 1995 (Ishitani et al.), this technique is still relatively unexplored in the field of neuroscience except by a limited number of individuals (ex. Blazquez-Llorca et al., 2013; Khanmohammadi et al., 2015; Maco et al., 2014). As of this writing, FIB-SEM has not yet entered the field of learning and memory, let alone song learning. This is despite a recent abundance of techniques facilitating semi-automated analysis of synapses within FIB-SEM volumes (Kreshuk et al., 2011; Morales et al., 2011). The aim of this study is to take advantage of this advanced technology to investigate the ultrastructural changes that occur in the songbird brain as a result of song learning. This includes investigations of changes in size of the synapse itself, complementing recent findings of changes in dendritic spine size (Roberts et al., 2012; Roberts et al., 2010), as well as changes in synapse curvature, which have been shown to be related to learning in other model systems (Medvedev et al., 2010) but as of yet have not been studied in zebra finches.
Materials and Methods

I. Subjects

Electron Microscopy Studies

12 male zebra finches were raised in the animal facility at the Institute of Neuroinformatics for use in electron microscopy studies. Birds were maintained on a 14:10 light:dark cycle, and were given *ad libitum* access to food and water. Birds were kept in breeding cages with their parents and siblings until 15 days post-hatching (dph). At that time, the juveniles and their mother were separated from the father and transferred to a different room equipped with acoustically isolated cages, each holding a single clutch. At 35 dph, the experimental subject was moved to an individual acoustically isolated holding cage, where it remained until sacrifice at 59 dph. Experimental procedures were in accordance with the Veterinary Office of the Canton of Zurich.

Protein Expression Studies

13 male zebra finches were raised in the animal facility at Wellesley College for use in protein expression studies. Birds were maintained on a 16:8 light:dark cycle. Birds were kept in breeding cages with their parents and siblings until 8 (± 0.3 SEM) days post-hatching (dph). At that time, the juveniles and their mother were separated from the father and transferred to a different room equipped with acoustically isolated cages each holding a single clutch. At 32 dph, the experimental subject was moved to an individual acoustically isolated holding cage, where it remained until sacrifice at 59 dph. Experimental procedures were in accordance with U.S. law and approved by the Institutional Animal Care and Use Committee (IACUC) of Wellesley College.

Tutoring Paradigm

Subjects were raised according to one of three possible tutoring-scenarios that differed in the amount of exposure to a live tutor (Figure 6). Fully isolated (ISO) birds, received no exposure
to tutor song, remaining in complete song isolation. Long-tutored (LTU) birds were housed with a tutor starting at 35 dph, and ending on the date of sacrifice, 59 dph. The tutor, an adult male zebra finch, was housed with the juvenile 24 hours a day. Alternatively, Short Tutored (STU) birds received only one full day of tutoring, beginning 24 hours before sacrifice. A tutor was housed with the juvenile 24 hours before the time of sacrifice at 59 dph. All vocalizations of all animals were recorded beginning at 32-35 dph for analysis of song learning behavior.

**Figure 6: Experimental set-up.** Birds were kept in isolation from song until 35 days post-hatch, and received varied levels of song exposure from a male tutor from 35 to 59 dph. At 59 dph, all subjects were processed for electron microscopy or protein expression experiments.

### II. Electron Microscopy

On day of sacrifice, experimental subjects were given a lethal dose of pentobarbital. Once deeply anesthetized, the animal was mounted with its wings and legs spread, and the thorax was opened to allow access to the heart. 20 µL of heparin were injected into the left ventricle, and a small incision was made in the right atrium. The bird was then perfused with 5 mL 0.9% NaCl, followed by 300 mL 4% paraformaldehyde (PFA) and 0.1% glutaraldehyde in phosphate buffer (0.1 M, pH 7.4, PB). The head was removed, and the whole brain was dissected out and washed in PB. Prior to sectioning, the brain was embedded in 3% agar for stability. Using a vibratome, the
brain was cut into 100 µm sagittal sections. Five sections from each hemisphere of each subject containing HVC were selected for further processing.

Sections are transferred into glass cylinders containing Sodium Cacodylate Buffer (0.1 M, pH 7.4), and rinsed three times in buffer. Tissue was then fixed in 1.5% Potassium Ferrocyanide and 1% Osmium tetroxide in Sodium Cacodylate Buffer for 40 min, followed by 1% Osmium tetroxide in buffer for another 40 min. Sections were then incubated in 1% uranyl acetate in distilled water for 40 min for additional contrast. Tissue was dehydrated in a graded alcohol series diluted in deionized water, 10 minutes for each change, and 15 minutes for the final two changes (1 x 50%, 1 x 70%, 1 x 90%, 2 x 100%). Finally, sections were rinsed in propylene oxide twice for 15 minutes for complete dehydration. After dehydration, sections were embedded in Durcupan ACM epoxy resin (10 g component A/M, 10 g component B, 0.3 g component C, 0.2 g component D) overnight. Sections were sandwiched between two ACLAR 33C embedding film, which in turn were sandwiched between two glass slides with small weights on the upper slide. Sections were then cured at 52 °C over 48 hours. Once cured, a region of interest within HVC was re-sected from one brain section into a small block of tissue. The surface of this block was then trimmed with a diamond knife into 70 nm sections carbon-coated for imaging with a FIB-SEM (Zeiss Auriga 40). This resulted in electron microscopy image stacks with 5x5 nm pixels and 10 nm inter-slice distances, except for two subjects with 3.85 x 3.85 nm pixels (Figure 7). This translates into 12 volumes, one per subject, with a width and length of 8 µm, and a depth of 8.5 µm (± 0.3 SEM).
Figure 7: Example of electron microscopy volume. Imaging of brain slices with a FIB-SEM results in high resolution electron microscopy volumes of approximately 8 µm³ and voxels (three-dimensional pixels) of 5 x 5 x 10 nm³, as rendered here (Image courtesy of Ziqiang Huang).

III. Immunohistochemistry

On day of sacrifice, experimental subjects were perfused using the same method used for electron microscopy subjects, with one minor change in the solutions used: the bird was perfused with 5 mL PB (0.1 M, pH 7.4) followed by 200 mL of 2% PFA in PB (0.1 M, pH 7.4). The brain was sectioned using a vibratome into 50 µm sagittal sections, which were stored at -20 °C in cryoprotectant (1% PVP-40, 30% sucrose, 20% ethylene glycol in 0.1 M PB, pH 7.4) for future use.

3 sections from each bird containing HVC were selected and transferred to 24-well plates containing PB (0.1 M, pH 7.4). At this point, sections and solutions were kept at 4 °C unless otherwise noted, and plates gently stirred on a rotator during all washes and incubations. Sections were first washed three times in PB to rinse off cryoprotectant, then three times with 0.01% bovine serum albumin-c and 0.3% Triton X-100 in PBS (0.1 M, pH 7.4, PBT-BSA) for 10 minutes each. Next, sections were blocked with 5% normal goat serum diluted in PBT-BSA for one hour at room temperature, and rinsed off with three 5 minutes washes in PBT. Sections were incubated in primary antibody (1:4000 Gephyrin, 1:2000 PSD-95; Table 1) diluted in PBT-BSA for 48 hours.

Primary was rinsed off with PBST 10 times within one hour, approximately once every 6 minutes. From this point on, sections were kept in the dark to prevent quenching of fluorescent
signal. Sections were incubated in secondary (1:500) diluted in PBT for two hours at room temperature, then were rinsed three times for ten minutes in PBT. Cell nuclei were then stained by incubation in 0.1 µg/mL Hoescht 33342 solution in PBS for 5 minutes at room temperature. The solution was rinsed off by three 5 minute washes in PBS, followed by one quick rinse in distilled H₂O. Sections were mounted on slides and allowed to dry prior to coverslipping with Fluoromount. Coverslips were sealed with clear nail polish and slides were stored in the dark at 4 °C.

**Table 1:** Antibodies used in this study

<table>
<thead>
<tr>
<th>Antibody</th>
<th>Description</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anti-Gephyrin</td>
<td>Rabbit Polyclonal</td>
<td>Cell Signaling Technology</td>
</tr>
<tr>
<td>Anti-PSD95</td>
<td>Mouse Monoclonal</td>
<td>Synaptic Systems 124011</td>
</tr>
<tr>
<td>Cy5-conjugated secondary</td>
<td>Goat Anti-Rabbit IgG (H+L)</td>
<td>Jackson ImmunoResearch</td>
</tr>
<tr>
<td>Cy2-conjugated secondary</td>
<td>Goat Anti-Mouse IgG (H+L)</td>
<td>Jackson ImmunoResearch</td>
</tr>
</tbody>
</table>

HVC within each double-immunostained section was imaged under a Leica laser scanning confocal microscope (Leica TSC SP5 II) using Leica confocal software with 63X PLAN-APO oil objective. Only one laser was turned on at any given time during imaging to eliminate overlap between excitation wavelengths of fluorophores. The gain and offset were optimized for each fluorophore to show the most signal and least background, and were kept consistent throughout the entire study (Table 2).

**Table 2:** Confocal Imaging Settings

<table>
<thead>
<tr>
<th>Fluorophore</th>
<th>Channel</th>
<th>Laser</th>
<th>Intensity</th>
<th>Gain</th>
<th>Offset</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hoescht 33342</td>
<td>DAPI</td>
<td>405 Diode</td>
<td>20%</td>
<td>650</td>
<td>-2.0</td>
</tr>
<tr>
<td>Cy2</td>
<td>FITC</td>
<td>HeNe 488</td>
<td>33%</td>
<td>800</td>
<td>-4.0</td>
</tr>
<tr>
<td>Cy5</td>
<td>Cy5</td>
<td>HeNe633</td>
<td>33%</td>
<td>800</td>
<td>-4.0</td>
</tr>
</tbody>
</table>
IV. Image Analysis

Synapse Count & Size

Images obtained from the FIB-SEM were first aligned to form an image stack using TrakEM2, an ImageJ plugin used for analysis of three-dimensional data (Cardona et al., 2012). All synapses within a stack were manually labeled as asymmetric or symmetric within the software (Figure 8a). Subsets of 200 consecutive slices from a whole stack were imported into ilastik, an interactive machine learning tool which facilitates image segmentation with limited human training (Sommer et al., 2011). This software has been used to detect and segment synapses from SEM and FIB-SEM volumes (Kreshuk et al., 2014; Kreshuk et al., 2011); the procedure outlined here is adapted from those previously published. Briefly, volume subsets were trained to classify voxels into one of five categories: synapses, mitochondria, membrane, vesicles and ‘rest of stack.’ For each training set, four synapses, eight mitochondria, four membrane segments, 10 vesicles, and 4 areas containing none of these features (‘rest of stack’) were labeled on 20 slices evenly dispersed throughout the image stack, in addition to 40 more synapses also labeled throughout the stack. All labels were made using the point 7 brush, except for vesicles which were labeled using the point 1 brush.

After training, the algorithm was set to differentiate voxels according to the features listed in Table 3 and applied to the whole training stack. This resulted in a pixel prediction map, in which each voxel within the entire stack is predicted to belong to one of the five categories (Figure 8b). The prediction map was then input into the object classification workflow to convert the pixel predictions into segmented “objects” (synapses). The prediction map was smoothed using a Gaussian with a standard deviation of 10 voxels to remove noise that might cause discontinuities within objects, and a threshold applied to consider only clusters of voxels with a synapse probability greater than 50%, and of at least 10000 pixels in size. The resulting segmentation could then be exported as a binary tiff file, in which objects (synapses) were indicated by white voxels, and other voxels by black (Figure 8c).
Table 3: Voxel Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Sigmas (i.e. scale relative to voxel size)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Intensity of the Gaussian-smoothed image</strong></td>
<td>0.7, 1.0, 1.6, 3.5, 5.0, 10.0</td>
</tr>
<tr>
<td><strong>Eigenvalues of the Hessian matrix</strong></td>
<td>1.6, 3.5, 5.0, 10.0</td>
</tr>
<tr>
<td><strong>Laplacian of Gaussian</strong></td>
<td>3.5, 5.0, 10.0</td>
</tr>
<tr>
<td><strong>Difference of Gaussians</strong></td>
<td>5.0, 10.0</td>
</tr>
<tr>
<td><strong>Eigenvalues of the structure tensor</strong></td>
<td>5.0</td>
</tr>
</tbody>
</table>

The exported segmentation file was then analyzed and proofread using a MatLab script, which allowed for manual identification and removal of false positives: objects which were falsely determined by the algorithm to be synapses. Additionally, minor corrections to ilastik segmentation were made, including merging of objects which make up one synapse and splitting objects which include two synapses. Synapses which were not fully included within the image stack, touching one of the edges of the stack, were also removed from the data set, as accurate size and curvature calculations could not be obtained for these objects. A small percentage of synapses were not detected by the ilastik software, and thus were also excluded from further analysis. The volume of each synapse within the final dataset was then calculated based on the number of voxels in each object and the size of each voxel within the image stack, as was the maximum Feret’s diameter (the maximum length of the object in any orientation).

Figure 8: Electron microscopy image analysis. (a) Electron microscopy images were collected and aligned using TrakEM, and synapses were manually labeled ‘asymmetric or ‘symmetric.’ (b) Ilastik pixel classification with limited human training, classified as: synapse (red), membrane (green), mitochondria (blue), and rest of tissue (yellow). (c) Visualization of synapses within a 3-D volume.
Synapse Curvature

Segmentations were binarized and input into EspINA, a software that enables measurement of synapse morphometric features, such as synapse curvature (Morales et al., 2011; Morales et al., 2013). All synapses in the final dataset were labeled in EspINA using the grey level segmentation tool with a threshold of 200. Minor corrections, including splitting and merging, were made to segmentations through the software. Synapses were classified manually by type (symmetric or asymmetric) or curvature (concave, convex, flat, or irregular). Quantitative information about the curvature of each synapse within a stack could be obtained by using the Synaptic Apposition Surface measurement tool. Many parameters describing synapse curvature were calculated; mean maximum curvature was chosen for further analysis, as the obtained values best matched the curvature of synapses based on qualitative observation (Figure 9).

![Image of synapse curvature measurements](image_url)

Figure 9: Measurement of synapse curvature. Binarized image segmentation files were input into EspINA in order to obtain quantitative measurements of synapse curvature. Panels (a)-(d) show representative synapses and synapse apposition surfaces (blue) for corresponding curvature measurements. All raw measurements obtained using EspINA were positive; convex synapse measurements were negated in order to differentiate between concave and convex curvatures. Adjusted maximum curvature values were normalized to fit within a range of -1.0 to 1.0.

Protein Expression

Expression of PSD-95 and gephyrin protein was quantitatively assessed based on the intensity of immunofluorescence of the secondary antibodies Cy2 and Cy5, respectively, for HVC in each section. Images obtained with confocal microscopy were input into ImageJ software, through
which mean fluorescent intensity of the whole image containing the region of interest was measured using the ‘Measure’ function and collecting the ‘Area.’

V. Statistical Analysis

To investigate which synaptic features were affected by changes in song exposure, these features were compared between Fully Isolated birds (ISO), Short Tutored birds (STU), and Long Tutored birds (LTU) with a linear mixed-effects model. These models describe the relationship between dependent and independent variables, differentiating between fixed effects (experimental group, synapse type) and random effects (variation between subjects in a given experimental group), and including the possibility that changes in synapse morphology within an experimental group may be specific to one synapse type (symmetric or asymmetric). Prior to statistical analysis of synapse size and volume, data was natural-log normalized. No statistical analysis of protein expression values was conducted due to low (N≤3) sample sizes in the final data set.
Results

I. **Synapse Size and Curvature**

In order to measure changes in synapse size and curvature associated with song exposure, FIB-SEM volumes were collected from birds with different amounts of song exposure. Each synapse within each stack was then segmented, and further processing enabled the determination of the volume, Feret’s diameter and curvature of each synapse within a stack (Table 4). Synapses which were not completely included within the stack were excluded from analysis, as were false negatives. These include synapses which were not detected or not well segmented by the image segmentation software. False negatives made up a small percentage of total synapses, with an average of 2% false negatives per stack. This often occurred when a synapse was in close proximity to myelin sheath, an issue which has also been noted by the software developers (Kreshuk et al., 2011). An average of 326 (±19 SEM) total synapses per bird were used in the final dataset.

**Table 4: Information on Electron Microscopy Image Stacks**

<table>
<thead>
<tr>
<th>Subject ID</th>
<th>Experimental Group</th>
<th>Volume depth (slices)</th>
<th>Number of Synapses (manual)</th>
<th>Number of synapses included in final measurements¹</th>
<th>Percentage of false negatives¹</th>
</tr>
</thead>
<tbody>
<tr>
<td>502</td>
<td>ISO</td>
<td>800</td>
<td>456</td>
<td>375</td>
<td>3.4%</td>
</tr>
<tr>
<td>603 (B1)</td>
<td>ISO</td>
<td>813</td>
<td>394</td>
<td>320</td>
<td>2.2%</td>
</tr>
<tr>
<td>704 (B2)</td>
<td>ISO</td>
<td>841</td>
<td>463</td>
<td>369</td>
<td>1.6%</td>
</tr>
<tr>
<td>1404</td>
<td>ISO</td>
<td>800</td>
<td>381</td>
<td>324</td>
<td>7.1%</td>
</tr>
<tr>
<td>901 (D2)</td>
<td>STU</td>
<td>800</td>
<td>253</td>
<td>202</td>
<td>0.99%</td>
</tr>
<tr>
<td>909 (D1)</td>
<td>STU</td>
<td>1106</td>
<td>299</td>
<td>200</td>
<td>1.0%</td>
</tr>
<tr>
<td>1014</td>
<td>STU</td>
<td>734</td>
<td>410</td>
<td>362</td>
<td>1.1%</td>
</tr>
<tr>
<td>1618</td>
<td>STU</td>
<td>931</td>
<td>471</td>
<td>375</td>
<td>1.9%</td>
</tr>
<tr>
<td>410 (C1)</td>
<td>FTU</td>
<td>353+448</td>
<td>184+189</td>
<td>355</td>
<td>0.28%</td>
</tr>
<tr>
<td>801 (C2)</td>
<td>FTU</td>
<td>893</td>
<td>499</td>
<td>406</td>
<td>1.2%</td>
</tr>
<tr>
<td>1227</td>
<td>FTU</td>
<td>800</td>
<td>389</td>
<td>326</td>
<td>0.61%</td>
</tr>
<tr>
<td>1503</td>
<td>FTU</td>
<td>822</td>
<td>361</td>
<td>299</td>
<td>3.0%</td>
</tr>
</tbody>
</table>

¹This includes only synapses that were fully contained by the image stack, for which volume and curvature could be accurately measured
**Synapse Size**

The average mean synapse volume in HVC for each bird was $7.0 \times 10^7$ nm$^3$ (±1.0 x 10$^7$ SEM). A linear mixed-effects model (LMM) was used to detect differences in synapse volume in HVC. No significant changes in overall synapse volume related to experimental group was observed, although volumes of birds after one day of tutoring (STU) appear to be larger than those of isolate birds (ISO) or birds with several weeks of tutoring (FTU; Figure 10a). Asymmetric synapses were found to be significantly larger than symmetric synapses (LMM, p<0.05), a property which was true for all subjects except one (Figure 10b). A significant relationship between synapse type and synapse volume between experimental groups was also observed, such that asymmetric synapse volumes were significantly larger in birds with song exposure (STU, FTU) as compared to song isolates (ISO) (LMM, STU vs. ISO p<0.001, FTU vs. ISO p<0.001). These finding may be skewed by one isolate bird, which unlike all other subjects, had symmetric synapses with larger volumes than the asymmetric synapses (Figure 10c).

**Figure 10: Synapse volume.** (a) Dot plot of the mean synapse volumes for subjects within each experimental group. (b) An increase in asymmetric synapse volume was observed in short-tutored (STU) and fully-tutored (FTU) birds compared to isolate (ISO) birds (***, LMM, STU vs. ISO p<0.001, FTU vs. ISO p<0.001). (c) Variation of synapse volumes for individual subjects is represented in a boxplot, where the band represents the median, the box represent the lower and upper quartiles, and the whiskers represent the minimum and maximum synapse volumes.
Similar analysis was conducted with respect to synapse diameter, again revealing no significant change in overall synapse diameter across groups (Figure 11a), and a larger diameter associated with symmetric synapses (LMM, \( p<0.05 \); Figure 11b). While significant, the difference in diameter between asymmetric and symmetric synapses was much less consistent than that of synapse volumes. Instead, only 7 out of 12 birds had a mean symmetric synapse diameter larger than the mean asymmetric synapse diameter. Interactions within the model revealed an increase in asymmetric synapse diameter relative to symmetric synapse diameter in STU birds as compared to ISO birds (LMM, \( p<0.005 \); Figure 10b). This change was not observed in the FTU experimental group, in which the mean symmetric synapse diameters were greater than the mean asymmetric synapse diameters, as was the case for the ISO group. However, observations in individual subjects suggest a weaker relationship between synapse diameter and synapse type, so that, while significant, the statistical difference between groups may not reflect any practical difference in diameter (Figure 11c).

**Figure 11: Synapse diameter.** (a) Dot plot of the mean synapse diameters for subjects within each experimental group. (b) An increase in asymmetric synapse diameter was observed in short-tutored (STU) but not fully-tutored (FTU) birds compared to isolate (ISO) birds (***, LMM, STU vs. ISO \( p<0.001 \)). (c) Variation of synapse diameters for individual subjects is represented in a boxplot, where the band represents the median, the box represent the lower and upper quartiles, and the whiskers represent the minimum and maximum synapse diameters.
Synapse Curvature

Changes in synapse curvature associated with song exposure were determined by manually categorizing synapses by curvature type (concave, convex, flat, irregular), and obtaining curvature measurements for each synapse using an image segmentation software. These values were adjusted so that concave curvature measurements remained positive, while convex curvature measurements were negated in order to differentiate between convex and concave curvature, while synapses with flat or irregular curvatures were excluded from this analysis. Thus, differences in the degree of synapse curvature between experimental subjects could be determined.

No difference in overall synapse curvature was observed after analysis with a linear mixed-effects model (LMM), although a trend suggests that greater levels of song exposure may be associated with a higher degree of concavity (Figure 12a). Degree of synapse curvature was related to synapse type, so that symmetric synapses were more convex, while asymmetric synapses were more concave (LMM, \( p < 0.001 \)), a property which was true for all birds. A significant interaction between synapse type and experimental group was observed, such that this difference was more distinct in STU as compared to ISO birds (LMM, \( p < 0.05 \); Figure 12b). These finding may be skewed by one isolate bird, which had symmetric and asymmetric synapses which were more similar in degree of curvature than those of any other subjects (Figure 12c).
Figure 12: Synapse curvature. (a) Dot plot of the degree of synapse curvature for subjects within each experimental group. A flat synapse corresponds to a curvature value of zero, indicated by a dashed line. More positive values signify greater concavity, and more negative values greater convexity. (b) A greater difference in degree of curvature between synapse types was observed in short-tutored (STU) but not fully-tutored (FTU) birds as compared to isolate (ISO) birds (*, LMM, p < 0.05). (c) Variation of synapse curvature for individual subjects is represented in a boxplot, where the band represents the median, the box represents the lower and upper quartiles, and the whiskers represent the 1.5 times the lower and upper quartiles range. Outliers beyond this range are excluded.

II. Protein Expression

In order to confirm increased synapse size observed using electron microscopy, birds were tutored following a similar experimental paradigm, and HVC was analyzed for changes in PSD-95 and gephyrin protein expression using immunohistochemistry (Figure 13). Levels of PSD-95 and gephyrin protein expression within a synapse correlate with size of the synapse, and thus fluorescent intensity of staining of either protein may be used to indirectly measure changes in synapse size within a population. PSD-95 and gephyrin localize exclusively in excitatory and inhibitory synapses, respectively, so changes specific to each subtype may be investigated.
Figure 13: Immunohistochemical staining of HVC. Sections containing HVC from subjects with various levels of song exposure were stained for (a) cell nuclei (Hoechst 33342) (b) PSD-95 and (c) gephyrin. HVC was imaged with a confocal microscope at 63x.

13 birds total (ISO, N=4; STU, N=5; LTU) were used for this study, and three sections were collected from each bird for each experiment. Difficulty with selection of sections and loss of sections during immunohistochemical staining prevents this preliminary dataset from including all of the birds in the final analysis. The experiment was repeated twice, and mean fluorescence of PSD-95 and gephyrin was measured in all remaining sections (Figure 14). While no conclusions could be drawn from this dataset due to the low sample size, the second trial may suggest an increase in gephyrin fluorescent intensity with song exposure (STU, FTU) as compared to isolate birds (ISO).

Figure 14: Mean fluorescence of postsynaptic scaffolding proteins. Mean fluorescence of PSD-95 and gephyrin immunohistochemical staining was measured in HVC from birds of each experimental group (ISO, STU, FTU). The experiment was repeated twice and both the (a) first and (b) second trials are shown here. Error bars represent ±SEM.
Discussion

Changes in synapse size and curvature associated with song exposure were characterized in birds with varied levels in song exposure using FIB-SEM to collect electron microscopy volumes, followed by analysis using image segmentation software. This research represents one of few electron microscopy studies of the zebra finch brain, and the first in any model system to use FIB-SEM in order to thoroughly investigate changes in synapse ultrastructure associated with learning and memory. Prior investigations of ultrastructural changes in the songbird brain have relied on 2-D electron microscopy techniques which are less able to reliably quantify synapse shape measurements (Peng et al., 2012a; Peng et al., 2012b), or fluorescence microscopy techniques which allow experimenters to measure changes in larger neuronal structures, such as dendritic spines, but not in the synapse itself (Roberts et al., 2012; Roberts et al., 2010). Thus, these experiments represent significant advancements within the field.

Measurements of synaptic ultrastructure in HVC were made in song isolates, subjects with one day of tutoring, or several weeks of tutoring, enabling the investigation of structural changes occurring almost immediately upon the onset of learning. In this study, changes in synapse size and curvature were observed only 24 hours after song exposure. Although few early studies examined changes within this short timeframe, our findings confirm those of more recent studies in zebra finch HVC, which have noted increases in dendritic spine size and spine stability within 24 hours of tutoring (Roberts et al., 2012; Roberts et al., 2010). These rapid structural changes may represent initial encoding of song memory, forming the foundation for subsequent sensorimotor learning.

The majority of these findings are specific to asymmetric or symmetric synapses, supporting recent and historical studies which have shown that the excitatory and inhibitory systems may play distinct roles in learning and memory acquisition. This includes research in the chick hyperstriatum ventral (IMHV), in which an increase in size of (excitatory) spine, but not
(inhibitory) shaft, synapses after a learning paradigm has been observed (Horn et al., 1985). Studies in other learning paradigms, such as fear conditioning, have noted a decrease in inhibition via downregulation of inhibition-related genes (Bergado-Acosta et al., 2008; Heldt and Ressler, 2007), and reduced inhibitory currents in relevant brain structures (Lin et al., 2009). These studies and others suggest that disinhibition may be a characteristic feature of learning (reviewed by: Letzkus et al., 2015), and that structural plasticity may contribute to this phenomenon.

The functional consequences of these structural changes are as of yet unknown, but may be related to changes in the excitatory/inhibitory (E/I) balance. Maintenance of a balance between excitatory and inhibitory inputs in the brain is necessary for the stability of neural networks, and improper E/I balance has been associated with epilepsy (McCormick and Contreras, 2001), autism (Rubenstein and Merzenich, 2003), and numerous neuropsychiatric conditions (Fernandez et al., 2007; Kehrer et al., 2008). The importance of E/I balance in regulating the overall level of activity in postsynaptic neurons, controlling timing of action potentials, and in regulating the integration of multiple inputs has been demonstrated (Carvalho and Buonomano, 2009; Pouille et al., 2009; Wehr and Zador, 2003). Furthermore, theoretical studies have suggested potential mechanisms by which experience-dependent modulations of the E/I balance may occur based on models of Hebbian plasticity (Bartley and Dobrunz, 2015; Luz and Shamir, 2012). However, these studies do not address what role plasticity of E/I balance may play in learning.

Recent electrophysiological investigations in zebra finch HVC have provided potential answers to this question. Structural excitation and inhibition by RA projection neurons and HVC interneurons, respectively, has been found to underlie singing behavior in zebra finches (Kosche et al., 2015). Song learning appears to be coupled with increased inhibition in HVC, specifically targeting mastered sequences within a song (Vallentin et al., 2016). Together, these results confirm modulations of E/I balance within HVC during learning, and suggest that both inhibitory and excitatory systems play active roles in song learning. Additionally, these modulations
correlated with song performance, signifying a connection between E/I balance and extent of learning. In this case, inhibition may act to 'shield' learned sequences from further influence of tutor song.

Both changes in synapse size and curvature were observed in this study, confirming that ultrastructural changes which have been observed in other learning paradigms are also apparent in the songbird model. While significant differences in symmetric and asymmetric synapse size and shape were apparent, these remained constant among the total synapse population between groups. This contrasts with findings of increased synapse size in rabbit visual cortex (Weeks et al., 2007) and increased synapse convexity after long term potentiation in rat hippocampus (Medvedev et al., 2010). This may be due to differences in stimuli, or in how information is stored within these regions.

While electron microscopy methods are unable to directly relate changes in synapse morphology to alterations in synapse activity and function, other studies have attempted to address this issue. Synapse size is generally thought to signify increased synaptic strength and efficacy through release of more neurotransmitters and incorporation of more receptors into the post-synaptic density, resulting in a larger synaptic signal (Mackenzie et al., 1999). However, the implications of synapse curvature are less clear, and several hypotheses have been proposed. Theoretical studies suggest that higher degrees of curvature increase the proximity of receptors across the synapse, leading to greater synapse efficacy (Markus and Petit, 1989). Probability of vesicle release by the presynaptic neuron may also be affected, according to mathematical models (Ghaffari-Farazi et al., 1999; Ghaffari-Farazi et al., 1997). These models propose that synapses with high degrees of curvature restrict diffusion of presynaptic intracellular calcium. This increases local calcium concentrations, which are associated with greater probability of vesicle release.

Other limitations of this study include the inability to investigate synapse morphology in a single subject at multiple time points, as collection of tissue for analysis requires sacrifice of the
subject. Thus, in order to relate synapse morphology to song exposure, multiple birds with different amounts of exposure must be used, and changes inferred from comparisons between groups. *In vivo* fluorescence microscopy techniques have overcome this barrier, allowing experimenters to track changes overtime within a region as well as within a specific synapse. This technique has been used in zebra finch HVC to observe changes in dendritic spine stability and spine size (Roberts et al., 2012; Roberts et al., 2010). While fluorescence microscopy does not currently have high enough resolution to visualize synapse size and curvature, future advances in fluorescence microscopy may change this (reviewed by: Ehmann et al., 2015).

Although FIB-SEM microscopy enables collection of higher resolution images, the imaged area is generally much less than that of other electron microscopy techniques, such as ssTEM. In this study, an 8 x 8 x 8 µm cube was collected for each bird, while HVC total volume is nearly 1 mm³ (Bottjer et al., 1985). Random sampling of areas within HVC was used to ensure observed changes in synapse morphology were representative of HVC in its entirety, although some subregional differences between samples may still have impacted these measurements. A significant disadvantage to the small sample area is the inability to trace the origin of each synapse, and thus connect changes in synapse morphology with neuron type. Previous characterizations of HVC may be used to partially address this issue. Local interneurons have been identified as the sole sources of inhibition within the region (Mooney, 2000), while efferent projections from uvaeforrm nucleus (Uva) and the interfacial nucleus of the nidopallium (NIf) have been identified as sources of excitation (Akutagawa and Konishi, 2005; Vates et al., 1996). However, it is not possible in this dataset to thoroughly explore how changes in synapse morphology associated with song exposure, and neuron type may be related.

Included in this thesis is preliminary data in which PSD-95 and gephyrin expression was measured. As amounts of PSD-95 and gephyrin protein are correlated with size of excitatory and inhibitory synapses, respectively, changes in synapse size found in electron microscopy may be confirmed by measurement of expression of these proteins. While no definite conclusions may be
drawn from the data, there appears to be an increase in gephyrin in birds with song exposure, as compared to song isolates. As gephyrin is found in inhibitory synapses, this would contrast with electron microscopy, in which excitatory synapses were found to increase in size after song exposure. One potential explanation for this discrepancy may be that the changes in fluorescent intensity are reflecting changes in synapse number, rather than size. A significant increase in the ratio of inhibitory:excitatory synapses is observed birds with song exposure, compared to song isolates (Ziqiang et al., data not published). Thus, an increase in gephyrin measured by this method may reflect this increase in inhibitory synapses, although more subjects per group are necessary to confirm this hypothesis.

In summary, this thesis shows that exposure to song in juvenile zebra finches results in changes in synapse size and curvature. Specifically, asymmetric synapse size increased relative to symmetric synapses in birds after exposure to song, while an increased degree of convexity was observed in symmetric synapses relative to asymmetric synapses after one day of song exposure. Together, these results suggest a link between song exposure and synapse morphology whereby experience acts in the juvenile brain to provide a foundation for learning new behaviors.
Appendix: Protocols

Immunohistochemistry

**NOTE: When using fluorescent secondary antibodies (so on Day 2 and after) never work with these in the light! Always protect the antibody and sections with the antibody from the light! Use foil and the dark.

1. The night before your immune, sort your sections from cryoprotectant into PB.

**Immu Day 1:**

1. Rinse sections 3x for 5 min. each in 0.1 M PB on ice on shaker.
2. Rinse in 0.2 M PBS with 0.01% BSA-c (10% stock) 3 x 10 min.
3. Incubate with 5% normal goat serum (100% stock) diluted in PBS with 0.01% BSA-c for 30 min at room temperature.
4. Incubate sections with anti-gephyrin (1:XXX) and anti-PSD95 (1:XXX) in blocking solution for 48 hrs at 4 C on a shaker.

Blocking solution = 0.1 M PBS, 0.3% Triton X-100 and 2% NGS
For Triton X-100 use, recommend diluting in water and then diluting to PBS solution. Always make sure to pipette up slowly when using Triton-X and remove the pipette slowly from the container of Triton-X as it is very soap-like.

**Immu Day 2:**

1. Rinse sections in PBT (0.1M PBS, 0.3% Triton X-100) 10 x within one hour (rinse every 6 minutes).

FOLLOWING STEPS PERFORMED IN THE DARK!!

2. Incubate sections with secondary antibodies (CY3 and CY5) for 2 HRS. in the dark at room temperature on the shaker. The antibodies are diluted in 0.1 M PBS with 0.3% Triton-X solution.

Wrap well plates in aluminum and put the brown cardboard box over them while on the shaker. Also turn the lights off.

3. Rinse sections 3x for 10 min. each in 0.1 M PBS on shaker.

4. Incubate in 1 μg/mL Hoescht 33342 solution (200 ul per well) for 5-10 min at room temperature (37° C), covering with aluminum foil to protect it from light (40 RPM)

5. Hoescht is available in 1-mL aliquots in the freezer at a stock concentration of 1 mg/mL

6. Dilute 1:10000 for a working solution concentration of 0.1 μg/mL (in PBS)

7. Wash 3 x 5 minutes in PBS
8. Mount sections on slides using a soft brush. DO NOT use the special slides for this experiment. Use the normal slides.

9. Carefully dab the water off the slide with a kim-wipe. Wait about 15 to 20 minutes for sections to dry a little.

10. Apply 3 consecutive dots of Fluoromount-G with the tip of a glass pipette to the slide so that they cover your sections.

11. Carefully lower down a coverslip so that your sections are fully covered with Fluoromount-G and there are no air bubbles under the coverslip.

12. Do this carefully and then once the coverslip touches a bit of Fluormount-G on the slide, let the mounting medium pull the coverslip down.

13. Apply lots of clear nail polish around the edge of the coverslip to seal out the air.

14. Store upright in the dark and allow to dry overnight.

15. The next day, wrap your slide in foil and put it in the fridge.

**NOTE ON SECONDARY ANTIBODY STORAGE**

Small microcentrifuge tubes of CY3 and CY5 are held in a pipette array in the industrial freezer in the hallway of the 3rd floor labs. The array is labeled with Gobes Lab and is on the very bottom shelf of the freezer (in Beltz storage)

Bring foil to the freezer so that you can immediately wrap the antibodies from the freezer holder for storage later. THESE CANNOT BE EXPOSED TO LIGHT!!

When you use this freezer – unlock the freezer by pressing the lever down and pulling it on. Wearing the gloves provided next to the freezer, pull out the door for the lowest shelf. Then look for the array: it is labeled with a pink piece of tape, there is foil under the plastic cover, and the bottom is yellow. It should be on the left side but close to the middle.

Take this out and get out one vial of CY3 and CY5. Immediately wrap these microcentrifuge tubes in foil.

Put the array with the rest of the tubes back in the freezer and close and lock the freezer carefully. Make sure not to keep this open for too long otherwise the temperature will drop and an alarm will go off!

Label these antibodies and store at 2 – 4 C in fridge. **These last up to 6 weeks in fridge storage! SO ALWAYS take note of when you took out secondary antibody and do not use it outside of the 6 week period.**
Dot blots

Required Buffers
- **RIPA Lysis and Extraction buffer** (#89900, ThermoFisher)
- **TBS**: 10x stock recipe = 12.1 g Tris-base, 58.44 g NaCl, completely dissolve in some water and bring to pH 8.0, bring to final volume of 1 L
- **Wash Buffer (TBS-T)**: 10x stock = 100 mL of 10x TBS + 1 mL Tween 20
- **Blocking solution**: 5g of Blotting-Grade Blocker (Bio-rad 170-6404) in 100 mL wash buffer (1x TBS/0.1% Tween 20), keep at 4 °C

Tissue Collection & Homogenization
1. Dissect out brain, divide into halves, and place in autoclaved 1.5 mL microcentrifuge tube. Immediately freeze in liquid nitrogen and store at -80 °C for later use.
2. Chill tubes along with mortar and pestle on ice at least one hour prior to homogenization.
3. For half a brain, prepare 1 mL of buffer + protease inhibitors: add 0.1 mL protease to 0.9 mL cold RIPA buffer and mix.
4. Add 500 μL buffer to tube containing tissue and homogenize using the mortar and pestle. Freeze remainder of buffer + inhibitor in -20 °C freezer for later use.
5. Incubate on ice for 30 min. Invert tube every 10 min.
6. Centrifuge at 13 K for 30 min at 4 °C and collect supernatant (liquid). Be very careful to not pipette out any of the pellet along with the supernatant.
7. Store 100 uL aliquots of supernatant in -80 °C fridge, as well as the pellet in a separate tube. Leave any samples for immediate use on ice.

Dot Blot
1. Thaw samples if necessary.
2. Prepare a strip of nitrocellulose membrane with enough room for your sample (or multiple samples), as well as a negative and positive control.
3. Cut off the top left-hand corner of each strip to differentiate between the bottom and top of strip.
4. Pre-wet each membrane in wash buffer and allow to dry.
5. Pipette up to 10 uL of each solution onto the strip and allow to dry
   a. RIPA buffer (negative control)
   b. Sample: pipette a series of amounts of sample to look at different protein concentrations
   c. Primary antibody target hybridoma (positive control) – ex. if primary is goat anti-mouse, use mouse hybridoma
6. Place strip in 15 mL Eppendorf containing blocking solution, incubate for **1 hour at room temperature**.
7. Add primary antibody directly to the blocking solution and leave on shaker in cold room (4 °C) overnight.

Day 2
8. Collect block with primary antibody in tube and store at -20 °C for repeated use (can reuse 2-3 times without loss of signal)
9. Wash membrane with wash buffer: rinse quickly (~5s), for 15 min once, 10 min once, and 5 min once at room temperature
10. Add block with secondary antibody for 1 hr at room temperature.
11. Collect block with secondary antibody in tube and store at -20 °C for repeated use (can reuse 2-3 times without loss of signal)
12. Wash membrane with wash buffer: rinse quickly (~5s), for 15 min once, 10 min once, and 5 min once at room temperature
13. Place membrane on clean plastic sheet and dab off wash buffer with a clean paper towel
14. Spray on luminol (Denville Scientific Inc E2400) and leave for 1 min.
15. Dab off luminol and cover membrane with a plastic sheet. Visualize signal with the Biorad Chemi Imager
Western blots

Required Buffers
- RIPA Lysis and Extraction buffer (#89900, ThermoFisher)
- TBS: 10x stock recipe = 12.1 g Tris-base, 58.44 g NaCl, completely dissolve in some water and bring to pH 8.0, bring to final volume of 1 L
- Running Buffer: TRIS-HEPES-SDS buffer (Thermo #28398)
- Transfer Buffer: 10x stock recipe = 30.3 g Tris, 144 g Glycine, completely dissolve in some water and bring to pH 8.0, bring to final volume of 1 L
  o To dilute: 100 mL 10x stock, 200 mL methanol, 700 mL H₂O
- Wash Buffer (TBS-T): 10x stock = 100 mL of 10x TBS, 1 mL Tween-20 (0.1% after diluting)
- Blocking solution: 5g of Blotting-Grade Blocker (Bio-rad 170-6404) in 100 mL wash buffer (1x TBS/0.1% Tween 20), keep at 4 °C

Tissue Collection & Homogenization
8. Dissect out brain, divide into halves, and place in autoclaved 1.5 mL microcentrifuge tube. Immediately freeze in liquid nitrogen and store at -80 °C for later use.
9. Chill tubes along with mortar and pestle on ice at least one hour prior to homogenization
10. For half a brain, prepare 1 mL of buffer + protease inhibitors: add 0.1 mL protease to 0.9 mL cold RIPA buffer and mix. Rinse pestle in buffer prior to use.
11. Add 500 μL buffer to tube containing tissue and homogenize using the mortar and pestle. Freeze remainder of buffer + inhibitor in -20 °C freezer for later use.
12. Incubate on ice for 30 min. Invert tube every 10 min.
13. Centrifuge at 13 K for 30 min at 4 °C and collect supernatant (liquid). Be very careful to not pipette out any of the pellet along with the supernatant.
14. Store 100 uL aliquots of supernatant in -80 °C fridge, as well as the pellet in a separate tube. Leave any samples for immediate use on ice.

Running Sample
1. Thaw samples and dilute at 1:5 ratio in 5x loading dye.
2. Boil samples to disaggregate protein (5 min at 100 °C)
3. Prepare Gel box
   a. Fill center first with running buffer to check that it is not obviously leaking
   b. Pipette buffer into wells to remove storage solution and bubbles
   c. Run at ~83 volts to equilibrate
4. Load 20 μg of soluble protein into the gel, as well as a protein ladder.
5. Run for 90 minutes at 100 V: check to make sure the bands don’t reach the bottom of the gel.

Membrane Transfer
1. Disassemble the ready gel sandwich carefully so that the gel doesn’t tear. Remove the gel, soaking in some transfer buffer if needed; save the running buffer for repeated use.
2. Soak sponges (2), membrane (1) and filter paper (2) in transfer buffer ahead of time.
3. Assemble sandwich under buffer (from grey to black):
   a. Sponge
   b. Filter Paper
   c. Gel
   d. Membrane (roll out any bubbles)
   e. Filter paper
4. Close the cassette and place it into the electrode module with the gray side facing the black electrode, so that the proteins will migrate into the nitrocellulose membrane.
5. Put the electrode module into a tank and fill with cold transfer buffer.
6. Put this setup into the cold room and set to run at 34 V overnight (10-12 hours). Alternatively, for a quick transfer, first run at 34 V for 30 min, then turn up to 100 V for 1.5 hours.

**Antibody Incubation**
16. Disassemble the set up; the membrane should show markers transferred onto the membrane. The side previously touching the membrane should be more intensely staining – keep this side down throughout the rest of these incubations. Make sure all pieces of the gel are completely removed from the membrane before continuing.
17. Place membrane in gel box containing blocking solution. Incubate for 1 hour at room temperature.
18. Add primary antibody directly to the blocking solution and leave on shaker in cold room (4 °C) overnight.
19. Collect block with primary antibody in tube and store at -20 °C for repeated use (can reuse 2-3 times without loss of signal).
20. Wash membrane with wash buffer: rinse quickly (~5s), for 15 min once, 10 min once, and 5 min once at room temperature.
21. Add block with secondary antibody for 1 hr at room temperature.
22. Collect block with secondary antibody in tube and store at -20 °C for repeated use (can reuse 2-3 times without loss of signal).
23. Wash membrane with wash buffer: rinse quickly (~5s), for 15 min once, 10 min once, and 5 min once at room temperature.
24. Place membrane on clean plastic sheet and dab off wash buffer on a clean kimwipe.
25. Spray on luminol (Denville Scientific Inc E2400) and leave for 1 min.
Electron microscopy image segmentation

Ilastik Procedure

Pixel Classification

1. Open up ilastik. Under “Create New Project,” click “Pixel Classification”

2. Save project in Sharon’s folder in the Zerserker computer as “PixelClassification_BirdXY_SubstackZ_Date_initials.”

3. In the new window, click “Add New>Add a single 3D/4D Volume from Stack...” Select the stack that you listed for step 2 and press OK.

4. In the left sidebar, click “Feature Selection>Select Features.” Select the features as pictured in the image below.

![Feature Selection Image](image)

From 2014 paper:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Sigmas</th>
<th># of channels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intensity of the Gaussian-smoothed image</td>
<td>0.7, 1.0, 1.6, 3.5, 5.0, 10.0</td>
<td>1</td>
</tr>
<tr>
<td>Eigenvectors of the Hessian matrix</td>
<td>1.6, 3.5, 5.0, 10.0</td>
<td>3</td>
</tr>
<tr>
<td>Laplacian of Gaussian</td>
<td>3.5, 5.0, 10.0</td>
<td>1</td>
</tr>
<tr>
<td>Difference of Gaussians</td>
<td>5.0, 10.0</td>
<td>1</td>
</tr>
<tr>
<td>Eigenvectors of the structure tensor</td>
<td>5.0</td>
<td>3</td>
</tr>
<tr>
<td>Total number of features</td>
<td></td>
<td>26</td>
</tr>
</tbody>
</table>

Features used for pixel classification. All features were computed in 3D. The “Sigmas” column lists the sigmas of the Gaussians, used for smoothing the data (same sigma was used for all 3 dimensions). For the eigenvectors of the structure tensor, the second scale parameter was set to sigma/2, for the difference of Gaussians the second Gaussian sigma was set to 0.80/sigma.

doi:10.1371/journal.pone.0007551.s001

5. Click on “Training.” Add labels “Synapse” (red), “Membrane” (green), “Rest of Data” (yellow), “Mitochondria” (blue) and “Vesicles” (purple) → do not label any myelin (it messes with synapse segmentation).

6. Assuming there are 200 large slices, label every 30 slices (including 0) in the Z plane, with 4 brush strokes for each category, except for 8 labels for mitochondria and 40 for vesicles. Attempt to vary the features of each label, particularly the synapses (i.e. don’t label synapses
that all look exactly the same or are surrounded by similar things). Also, try to label about equal amounts in each quadrant of the slices.

- Use point 7 at 100% zoom when labeling most things, except use size 1 at 161% zoom for labeling vesicles.
- If there are not enough synapses in that slice, go 5 slices up and label the rest there.

7. Press “live update” and show the predictions. For every 10 slices besides those already labeled, use this uncertainty viewer to guide where you are labeling by labeling where the algorithm is incorrect (ex. Mitochondria edge labeled as synapse).

8. Label a synapse on each slice ending with 5.

**Examples of good labeling from 2011 paper (although they are not evenly distributed between slices):**

![Examples of good labeling from 2011 paper](image)

8. Press “Prediction Export>Choose Settings…” Make sure the format is hdf5 format and change the file destination to Sharon’s folder on Zerserker and the filename to “PixelClassification_BirdXY_SubstackZ_Date_initials.”

9. Press “export all.” Wait as ilastik exports the prediction. This will take about 30 min.

10. Apply this training to the rest of the stack by pressing “Batch Prediction Input Selections,” and adding the rest of the stack under “Add File(s)…” Then go to Batch Prediction Input Selections, applying the same settings as in step 9, and changing the file name to “PixelClassification_BirdXY_SubstackZ_batch_Date_initials.”

11. Press “export all” again. This should take awhile.

**Object Classification**

1. Quit ilastik and reopen. Under “Create New Project” select “Object Classification (from prediction image).”

2. Save project in Sharon’s folder in the Zerserker computer as “ObjectClassification_BirdXY_SubstackZ_Date_initials.”

3. In the new window, click “Add New>Add a single 3D/4D Volume from Stack...” Select the stack that you listed for pixel classification and press OK.

4. Under “Prediction Maps,” click “Add New>Add separate Image(s)...” Select the data you exported from pixel classification for that stack.
5. Under Threshold and Size Filter, for channel 0 set the threshold as 0.50 and the size range as 100 to 1000000.

From 2014 paper:

To detect synapse candidates in pixel probability maps produced in the previous step, we threshold the synapse probability map at 0.5, run connected components analysis and discard very small (less than 100 pixels in our test dataset) and very large (more than 1000000 pixels) connected components. For the

6. Under “Object Feature Selection” click “Select Features” and select the features imaged below.

From 2014 paper:

<table>
<thead>
<tr>
<th>Table 2. Object features.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feature</td>
</tr>
<tr>
<td>Mean</td>
</tr>
<tr>
<td>Mean, object neighborhood</td>
</tr>
<tr>
<td>Variance</td>
</tr>
<tr>
<td>Variance, object neighborhood</td>
</tr>
<tr>
<td>Skewness</td>
</tr>
<tr>
<td>Skewness, object neighborhood</td>
</tr>
<tr>
<td>Kurtosis</td>
</tr>
<tr>
<td>Kurtosis, object neighborhood</td>
</tr>
<tr>
<td>Local binary patterns/ histogram</td>
</tr>
<tr>
<td>Local binary patterns/ histogram, object neighborhood</td>
</tr>
<tr>
<td>The ratio of the largest principal component to the smallest</td>
</tr>
<tr>
<td>Total number of features</td>
</tr>
</tbody>
</table>

Features used for object classification. The size of the neighborhood is specified in pixels for x, y and z dimensions. The neighborhood was computed using anisotropic distance transform in 3D.
7. Select “Object Classification>Subset Features.” Make sure all checkboxes are checked.

8. Add labels “Synapses” (green) and “False Positives” (red).

9. Go through every slice ending in 5 (plus slices 0 and 199) and classify every single object in each slice as either a synapse or a false positive. Be sure to scroll through stacks and look at other planes for any ambiguous objects, and be very precise with these classifications.

10. Check through stack every 17 slices and thoroughly and check to see if all of the rest of the predictions made by ilastik are correct. Correct any mistakes as you go along. Make sure to also check for false negatives.

11. Repeat for every 27 slices, 37, etc.

12. Export as multipage tiff to Sharon’s folder in Zerserker with the file name “SynapseSegmentation_BirdXY_SubstackZ_Date_initials.”

13. Repeat the batch processing steps from pixel classification for the rest of the stack, and export files as “SynapseSegmentation_BirdXY_SubstackZ_Batch_Date_initials.”

14. Export mitochondria segmentation as well, as multipage tiff to Sharon’s folder in Zerserker with the file name “MitochondriaSegmentation_BirdXY_SubstackZ_Date_initials.”

References


**MATLAB Analysis**

1. Make sure the working directory has only 1 '.tif' file, which is the original EM stack; only 1 '.tiff' file, which is the segmentation result; only 1 '.xls' file, which is the excel file stores manually identified synapse coordinates;

2. Open the excel file, and the 'iLastik_Crop_info.txt' file;
   - Find the corresponding stack (e.g.: Substack 1, or 2 or 3), and get the correct X-onset, Y-onset and Z-onset;
   - In the excel file, choose the 1st worksheet (should be called A1_all etc), and then type Alt+F8;
   - This brings up the macro dialog window, choose 'GetiLastikStackCoordinates' macro and click 'Run';
   - The macro asked for the X Y and Z onset, type in them correctly according to 'iLastik_Crop_info.txt' file;
   - The new coordinates corresponding to iLastik stack should be created after the 1st worksheet. You can leave it there, the matlab script will automatically load these coordinates later;

3. Doing analysis in Matlab:
   In Matlab:
   1. follow the same procedure as before (described in 'readme.txt') to do the following:
   stackLoader(path); %path is the string variable to indicate the data folder (contain the tif, tiff, and xls file indicated above)
   getMark(CC_segII); %create ID for the segmentations, this will take really long time, be patient;
   getMark(CC_segI,'white'); %also name those false-positive segmentations, this will take even longer, be patient;

2. get pair-wise analysis of distance between segmentation and TrakEM manual identified synapse coordinates:
   getDist(CC_segII,XYZ); % or getDist(CC_segII);

NOTE1: there will be a new variable created in the base Workspace called 'pairFound'; Basically the second column is the ID from CC_segII,
and the third column is IDs from XYZ (manually identified coordinates from excel file); the first column is the inter-pair distance;

NOTE2: You should use the Distance second threshold calculated from getDist (which display in the command window) to guide you. Verify the first distance that is larger than this threshold and check if it’s a correct pair, by using substack function show as follows:

\[
\text{substack(CC\_segII.centre(30).Centroid,Overlay\_marked,'big');} \quad %\text{if the 2nd column is number 30}
\]

\[
\text{substack(XYZ(70,[2,3,4]),Overlay\_marked,'big');} \quad %\text{if the 3rd column is number 70}
\]

If the above two images are belongs to the same synapse, then you can move on to the next pair, until you found the first pair that is not correct.

Once you found the first wrong-pair, you can basically store all the pairs (let’s say 76 pairs) before this row right away by doing this:

\[
\text{storePair(76); %store the founded pairs right away, depends on the user provided numbers}
\]

NOTE3: This function will again ask user to verify potential false-negative results (previously with getDist, but maybe different candidates.

It's better if you are working with Overlay\_marked created in the base Workspace. Then you can immediately get an overview with the false-negative results with the segmentation results (because many cases those false-negative are detected in false-positive channel, and of course you can take those into analysis later)

3, CLEAN UP the segmentations:

1, Basic segmentation structs operations: store & deleteSeg;

\[
\text{store(CC\_segII,3)} \quad %\text{this is to store the 3rd element of CC\_segII into a new struct called CC\_store;}
\]

NOTE1: CC\_store is very important for the analysis, because basically you can store those verified segmentation elements into it and only do analysis on it;

(e.g.: getSize(CC\_store); getFD(CC\_store); etc)

You already used it before when you do storePair(num);

NOTE2: CC\_store will be created the first time you store an element; and later stays in the base Workspace; When you run the command again it will keep adding new element in the end of CC\_store;
NOTE3: If you are trying to store an element that already been stored before, the function will warn you about it and return the stored element ID in CC_store to let you check. And therefore it won't store this element twice. Whenever this happens, it might because this element is a merged segmentation, which means it is actually two synapses. And you need to split it later (and don't forget to delete it before you store the splitted result, note it down is recommended).

NOTE4: To delete an unwanted entry in CC_store (or any other CC structs), you should use 'deleteSeg' command, as following:

```c
deleteSeg(CC_store,1); %this command delete the 1 element of CC_store, it will ask for your confirmation before really delete the element;
```

NOTE5: deleteSeg also works in different types as following:

```c
deleteSeg(CC_store,1,'safe');
delteSeg(CC_store,1,'fast');
```
- 'prompt' is the default (which means you don't need to type it), which will ask user for confirmation before delete operation;
- 'safe', which will store the deleted element in 'CC_deleted';
- 'fast', directly delete the element without any confirmation;

NOTE6: If you want to delete multiple elements automatically with deleteSeg, you have to aware each time you deleted an element in the struct, all the element IDs after the one you deleted are updated (which means -1); Therefore you should do the following to avoid mistakes:

1, create a 1-d array stores all the element IDs you want to delete:
```c
deleteID = [2;3;5;7;11;13;19]; %I want to delete element 2,3,5,7,11,13,19 of a given struct;
```
2, use the following batch deleting command with deleteSeg:
```c
delteSeg(CC_store,deleteID,'fast');
delteSeg(CC_store,deleteID,'safe');
```

NOTE: The key point of this operation is (hidden in the script) first sort the element from max to min values (which means for this example: 19;13;11;7;5;3;2). And then operate them in a loop to delete all the elements. In this way there won't be mistakes with updated ID.

2, get rid of false-negative and false-positive segmentations:
- Unfortunately till now (and probably also in the future) this part is highly rely on manual identification.
- Good thing is we have already done most of this by doing 'getDist' and 'storePair(num)': Those false-positive segmentations are not stored when you did "storePair(76);

- Before you checked those false-negative segmentations. Now it is the time to use this result. You can simply store the non-false-negative result into CC_store by using store(CC_seg,num);

NOTE: It's not ideal that you have to consider also the split/merge problem at this stage. This means if you have already found some split/merge mistake together with false-negative result (e.g.: the missing synapse is consist of several segmentations from CC_segI, the false-positive channel) There is not up-to-date automatic approach or better sequence of this problem. I suggest to always keep a form or piece of paper to note down the information of those problematic segmentations: what are they, what needed to be done to them before proceed to analysis.

2, get rid of splitted segmentations:
merge(CC_segII,2,4,5);

NOTE1: The 'merge' function can merge several segmentation together linearly.
You should provide the segmentation struct (CC_segII or CC_segI or CC_store), and which elements you would like to merge together; Note it's currently not working if you want to merge elements from different structs (e.g.: CC_segI - 3 and CC_segI - 4);

So if you need to merge the above example, you will have to do the following alternatives:
store(CC_segII,3); %and check which is the element for this in CC_store, it should be the last, let's say 77
store(CC_segI,4); %following 77, it should be element 78
merge(CC_store,75,76); %in this way you get a new element in CC_merged, with the two element from two structs;
Don't forget to delete the temporary stored segmentations 77 and 78 in CC_store (sorry for this inconvenience...)

NOTE2: Some information is retrievable in CC_merged.object.OriIdx; However it's not always keep everything (e.g.: last manipulation you won't be able to know which two you merged except CC_store 77, 78).

3, get rid of merged segmentations (THIS IS VERY TRICKY OPERATION, with some bugs):
split(CC_segII,76);
NOTE1: The 'split' function can split a segmentation into two segmentations, based on a user-defined separation plane.

NOTE2: You should strictly follow the following steps to get it properly done:

- You will be showed two images: a stack around the proposed segmentation object, and a 2-d image of the same object;
- You should first browse throught the stack, to get an idea how you will split it;
- Once you are ready, highlight the 2d image (It's very important, otherwise it won't work) by clicking on the title of it;
- Then type in the command window of matlab a slice number (the one you want to start, when browsing through the 3d stack): e.g: 87;
- The 2d image will be updated to the slice, and you will be provide a cross to working with, click onto the image to provide the splitting points; You can click as much as you like, but try to do it precise, and keep thinking a little in 3d;
- Once you are done with this slice, hit 'Enter', and then type a new slice number in the command window: e.g: 91; KEEP THE 2D IMAGE highlighted all the time, this is very important;
- Repeat last two steps until you are satisfied with the splitting points you provided; Then type 's' in the command window instead a slice number to terminate this manual selection.
- A figure with the 3d distribution of your points will be showed, a fitting plane will be calculated. You will be asked to display it or not. Type 'y' in the command window if you are satisfied with the points and want to see the plane;
- Then the fitting plane will be displayed onto the points; The figure will update, and you can zoom in, rotate to see if the 3d plane looks reasonable (should go through most of the points you provided);
- If you satisfied with the plane, type 'y' in the command window; The function will split the segmentation base on this plane. The splitted result will be stored in a new variable called 'CC_splited' in the workspace. Verify the splitting result by doing this:

```
substack(CC_splited.centre(1).Centroid,Overlay_marked,'big')
substack(CC_splited.centre(2).Centroid,Overlay_marked,'big')
```

This is to visualize the new centre of the two segmentation splitted, indicated by the green-cross;
- If it looks reasonable, then store them (or 1 of the two) into the CC_store;

NOTE3: Once you finished with one, delete CC_splited in workspace to work on the next splitting (Because each time you can only split one segmentation).

You have to do this manually by right-click on the variable 'CC_splited', and choose delete;
4. get rid of border segmentations (probably won't work very precise with whole stack, I need to think and work on this. before that, feel free to try):

borderFilter(CC_store);

NOTE1: This command will display all the border object one by one, for user to verify them;

NOTE2: The border information (which side is touching the border) will be displayed in the command window;

- This part you need to make your own judgement on should you remove this object or not (because touching the border doesn’t necessarily mean it is not complete; Also if you are doing analysis with parameters that won’t affected by the border.

- When iterating throught the border objects, you will be asked if this object you want to remove later. In the end you will be provided a list of the objects you want to delete, and stored in the variable called 'del' in base Workspace. If you are sure you want to delete them, you can use the following command:

```matlab
for i = length(del) : -1 : 1
delteSeg( CC_store, del(i), 'fast' );    % In this way you won't mis-delete unwanted elements;
end
```

3. get feret diameter:

getFD(CC_store);

NOTE1: The Feret diameter is the minimum bounding sphere of the 3d synapase (so it get rid of the pre/post synaptic density created volume differences; or it treat asymmetric and symmetric synapse more equal);

NOTE2: It take quite long to run this command. But it won’t need too much RAM. So you can do something else when let Matlab working on this.

NOTE: You should always save the key parameters in the workspace (e.g.:CC_store) to disk, and use that for analysis later.

NOTE: Don't forget the different pixel size in D1 and D2 stacks.

NOTE: In some case the huge stack (like those 800 or 1000 slices stack) won't work, then just skip it and leave it to me. There is not very convenient Matlab handling method for this right now. I will see how can we proceed (probably have to crop it again 400 by 400 slices or something like that).

Instructions for analysis
1. Load Overlay.mat file
   >> load('E:\rich\ZiqiangHuang\Houda\whole_stack\Matlab_variables\Overlay_marked.mat')

2. Set path to folder with stack info
   >> path = 'E:\rich\ZiqiangHuang\Houda\whole_stack\[stack]\whole_stack'

3. Load stack and get connected components
   >> stackLoader(path)

   ..... Get overlay image stack now? (y/n) n
   ...
   Get connected-components now? (y/n) y

4. Get mark from CC_segAll file
   >> getMark(CC_segAll)

5. Find distance between coordinates and ilastik segmentations; now should be stored in pairFound file
   >> getDist(CC_segAll)
   X extreme-close pairs are not unique, verify them now? (y/n) y

   Record which of these are synapses which need to be split

   X possible false-negative segmentation detected, verify them now or not? (y/n) y

   Record and confirm which are false negatives

6. Store all pairs found through getDist
   >> store(pairFound)

7. Repeat for each stack

Espina Instructions
Step 1: Create Files for use in Espina
- For each stack, there should be a tiff file with the EM stack (WholeStack_BirdXY_SubstackZ), and another with the synapse segmentation stack (SynapseSegmentation_BirdXY_SubstackZ_Batch_Date_initials).
- In order to use these in espina, the resolution must be reduced by 1/3, so that the file size is small enough. Otherwise, espina will crash.
  - To do this, open the stack in ImageJ, and go to Image>Adjust>Size…
  - Here, the width and height of the image will be given in pixels. Divide the width by 3 and replace the value given with the one you’ve calculated. The height will adjust accordingly. Press OK and allow ImageJ to process.
  - Save the new tiff by going to File>Save as…>tiff. Add “_thirdres” to the end of the file name. Repeat this for both the EM stack and the synapse segmentation stack.
- Use these files for the rest of the procedure in espina.

Step 2: To categorize synapses as Asymmetric and Symmetric
- You will need two screens to work: one will have the tiff on Zerserker and the other will have the tiff on the Linux
- On Zerserker, open a “synapse segmentation tiff” file in Trackem.
- Under “Z space” turn off all labels (turn off eye icon) except for symmetric and asymmetric synapses
- Transfer the synapse segmentation tiff to Linux:
  - On Zerserker, click file transfer in Teamviewer and select the file you want to transfer.
  - Press the transfer button and wait
  - The file will show up in Test Data folder on the Linux desktop
- Open Espina on the Linux (Click on circular icon> select Terminal > type in espina)
- Open the desired file on espina
  - Open File (blue folder) > add desired tiff file
- The tiff file will show all white segments which includes synapses and “junk.” (The synapses are typically the solid curved shapes)

- On the Zerserker tiff, turn off the asymmetric synapse icon (press the eye icon) so that only symmetric synapses are showing. Choose a highlighted symmetric synapse and locate the corresponding white curves on the Espina tiff.

- Once a synapse has been identified on Espina, click on Segment > Grey Level Segmentation and then click on the white synapse.

- Note: zoom in on the desired synapse before segmenting or it will not work.

- If 2 synapses are actually part of the same large synapse, segment each one individually and then select both synapses in the segmentation explorer. Then select Edit > merge > to make them one synapse.

- If 1 synapse is actually 2 synapses, select the synapse in the synapse explorer and then select Edit > Split Segmentation. Draw a line where you want to divide the synapse and then press the green check mark next the splitting icon.
Once all the symmetric synapses have been segmented and dragged into their correct category (the process of creating categories is discussed later), turn off the symmetric label on Zerserker Track EM tiff and turn on the asymmetric label (click on the eye icon).

Repeat the process with asymmetric synapses.

Once all symmetric and asymmetric synapses have been labeled, move forward 10 slices in the stacks on both screens and repeat the process.

**Step 3: To determine curvature**

- Once all synapses have been labeled asymmetric or symmetric, the curvature can be determined by overlaying a wholestack tiff file with the synapse segmentation file already on Espina.
- Click on Session >import file> and select the corresponding third resolution wholestack Tiff (use the ⅓ resolution file).
• Save this new file as a combination of these two files. This new file will be saved as a seg file.
• Click on Explore > Channel explorer (a brain icon) to see both files currently open
• Make sure the synapse segmentation tiff file is active (in bold)

  ▪ If the EM tiff file and the Synapse Segmentation file are misaligned: Select file in Stack Explorer > click on info icon (blue I) at the bottom > change X and Y spacing ratios (change both X and Y by the same number to keep them in correct proportion)

• Once the files are overlapped, determine the curvature of each synapse as described below
• Turn off eye icon next to a synapse number to find its location (look for the synapse that disappeared) or double click the synapse to bring it to the center of the screen.
• To zoom in: Explorer> Click on magnifying class icon> draw box around the section you want to zoom in on (box will not be visible)

• To zoom back out, press the 1:1 button next to the scrollbar

• To examine stack from multiple angles, click on visualize and select both “XY” and “YZ” buttons. Now all 3 planes of section will display on the screen and you can scroll through each one.

• Create categories by clicking on “create category” button at the bottom of the Segmentation Explorer. Create subcategories by selecting the category heading and then clicking on the subcategory button (to the right).
• Select the newly made category and give it a color by clicking on the “change category color” button (rainbow spectrum icon) and selecting a color.

![Hue Selection](image)

**Rules for determining curvature:**
• Determine the curvature of the POST synaptic bouton (look for presynaptic vesicles to determine which is the postsynaptic synapse)
  - If presynaptic pushes into postsynaptic → concave
  - If postsynaptic pushes into presynaptic → convex

![Synaptic curvature](image)

• In order to label curvature, the synapse must have the **same** curvature in at least 2 of the 3 planes of section
Note: Scroll through stack to check if a synapse is concave or convex, sometimes it changes throughout the stack

- If curvature in all 3 planes are different → irregular
- If synapse is at the edge of stack or too small to see → irregular
- If one perspective shows it flat and another shows curvature → choose the curvature
- If synapse has opposite curvatures in different planes → irregular

- Once a synapse curvature has been determined, drag the synapse into the desired category and it will change color

- Move through the stack 10 slices at a time
**Confocal microscopy**

**Startup**
1. Fill in starting time on user log sheet
2. Turn on the metal halide bulb (located right of the microscope), wait 30 seconds
3. Turn on the “PC Microscope switch” on the bottom panel. Allow the boot process to completely finish.
4. Turn on the “Scanner Power” switch, wait 20 seconds.
5. Turn on the “Laser power” switch
6. Activate the detachable key switch by turning it to the right and releasing.

**Preparing the software**
2. Double click on “LAS AF” on the desktop.
3. Say “no” to initializing the motor stage, say “ok” when asked “Check configuration of Machine?”
4. DO NOT touch the microscope as the software starts.
5. Click on the Configuration tab; click on laser.
6. Activate the correct laser (405 Diode - DAPI, HeNe 594 - streptavidin); click “Acquire”
7. Set the configuration to 10x or 20x on the main control panel.

**Preparing the sample on microscope**
1. Tilt condenser back to access stage, place the slide coverslip side down on the stage, replace condenser
2. On the microscope, push the appropriate button for the photofluor (green or red)
3. On the same panel, push the “shutter” button in the center to turn on the light.
4. Adjust the brightness if necessary using the panel on the bottom left of the microscope.
5. Use the remote focus controls to get a good view of the sample. The XY knob is in the front (X = top, Y = bottom), and the Y is to the back. Use precise before fast (fast is very fast).

**Viewing Settings**
1. In the software, look under “Load/Save single setting” and select the desired photofluor (DAPI for Hoesct, Texas Red for streptavidin).
2. Adjust the laser strength using the vertical slider. Use ~15-20%, or more for sections with bad signal.
3. Click the “Live” button on the bottom left of the screen.
4. On the top left right monitor, click this button:
5. Turn the Gain knob on the panel below the monitor to the right until it looks “good” – There should be no blue pixels.
6. Turn the Offset knob to the left – you’ve gone too far if green pixels begin to appear.
7. Click on the pictured button again to get a grayscale image, and again to get the original color image. You can adjust more here as well.
8. Press “stop” once all adjustments are made.
9. Press the “capture image” button to collect a single image.

**Z-stack settings**
1. Open the Z-stack window on the left side of the screen. Adjust the depth of the stack by entering values in the “begin” and “end” boxes to the left and right of the z-stack “cube.”

- To do this, click on the arrow beside one of the boxes to gray it out and adjust the z-position with the “Z-pos” knob until you get to a desired location (where the cells start to fade out). Un-grey out the box and repeat with the other box. [Right is closer to coverslip, left is further]

- You will not be able to go through a whole 50 um section with one stack, as settings will need to be adjusted every few (~10) um. Though you can potentially make a series of z-stacks through a section.

3. Adjust the distance between slices in the same window to what you need

4. Click on the “Start” button on the bottom right of the monitor to begin a z-stack series.

Saving Files

1. Open the “Experiments” window, right click “Experiment” and choose “Save Experiment As”
2. In the new window, open the drop down box and select (:D) → “data” → “Gobes Lab”
3. Next to the “file name” type in identifying info for the experiment, make sure file info is in .lif
4. Click save, check that files saved correctly in the location on the harddrive.
5. After you finish taking pictures, connect to NTM and transfer images to Gobes Lab; when connecting, do not check “reconnect at log on.”

Shutdown

If someone is booked afterwards:

1. Go to the “Configuration” menu and turn off all the lasers, and change the objective to 10x.
2. Close out of the LAS AF software and log out of the computer.
3. Lower the platform for the next user.
5. If no one is booked for the next hour, turn off the halide lamp.

If you are the last user for the day:

1. Turn off the halide lamp.
2. Close out of the LAS AF software, log out of the computer and shut it down.
3. On the control panel, turn the key to the “Off-0” position.
4. Turn off the “Scanner Power” and “PC Microscope” switches.
5. After 20 minutes, turn off the “Laser Power” switch as well (to allow fans to cool it down).

Improving Image Quality

- In the acquisition window, one can improve image quality by increasing resolution. The default is 512 x 512. 1024 x 1024 is better for good-quality images, though it will take longer.

- In the same window, frame averaging can be increased to improve image quality, though this will also cause image acquisition to take longer and bleach tissue more quickly. 4 is a good number, and more most likely won’t make a difference except for very bad pictures (6 may help).

- Line averaging, which I haven’t been using, can also make a difference. More than 2 or 3 is likely not helpful.

- Confocal images will inevitably be bad quality if the microscope lens is not focused.

- At 10x, even if the microscope lens is in focus, the confocal live image may appear unusually dark. In this case, adjustment with the “Z pos” knob can make the section more visible.
**Oil Immersion**

For higher magnification (x40), it is necessary to use oil immersion. To do this:

1. Switch to the oil immersion lens and remove the slide.
2. From the small bottle of oil, carefully add a drop of oil right to the top of the lens.
3. Lower the lens slightly so that it would not touch the slide, and replace the slide.
4. Turn the Z-knob and raise the lens until you see the drop of oil come in contact with the slide.
5. Open the shutter and look into the microscope. Raise the lens slowly. The field of view will slowly become brighter until suddenly your section comes into focus.
6. Precise focus requires a lot of **patience** and **precision**. If your original focus is unsatisfactory, or some parts of the field of view are blurry, try slowly moving the lens across the x-y plane.
7. If this does not work, there may be a bubble – try removing the slide, lowering the lens and trying again.
8. If this **still** does not work, try cleaning the lens (procedure described next), putting on new oil and trying again.
9. To clean lens:
   a. Using some lens paper, wipe off the oil from the lens.
   b. Wet another small piece of lens paper with “magic” purple liquid in a spray bottle. Carefully wipe the lens in **one direction** with it.
   c. With a dry piece of lens paper, dry the lens, again wiping in one direction.

Note: Be very careful not to get oil on any of the other lenses. You may use the 10x lens while there is still oil on the slide (being careful to not touch the slide), but not the 20x lens because it must get too close to the slide.

---

**Confocal Microscope notes 1/22/2014**

These notes are in addition to (or emphasizing) what’s written on Jeannie’s training sheet:

- Make sure to let the computer fully start up before turning on the lamp
- Do not lean on the microscope table
- Be sure to lower the stage after finishing with the microscope, and check that the stage lowered before turning on the microscope
- Do not initialize motorized stage unless necessary (needed for stitching)
- When focusing, use precise adjustment until you have more experience (fast adjustment is very fast).
- For beam path settings, Texas red is good for streptavidin, DAPI for Hoesct. We can also save our own user settings once we get good settings.
- Line averaging is useful for reducing noise -- anything more than 2 or 3 won’t really improve the image
- The emission spectrum shown after picking the settings is a “suggestion” based on fluorphore data
- The software will calculate a number of steps, but you can increase or reduce this based on your own needs
- After taking an image, nothing is saved automatically, so be sure to save immediately (and move to NTM right away) -- double check afterwards that everything was saved correctly
Statistical Analysis in R

R script:

For analysis of our ilastik data through linear regression with mixed effects:

1. Install R and R studio from online (these are already installed on the lab laptop).

2. Make a data file in excel or SPSS with these data in columns:
   - "group" - denotes what experimental group (1-4, or more) each bird was in
     - group 1 should be the isolate group
   - "bird" - the ID of each bird (1 - 8, or more)
     - birds 1 & 2 should be the isolate birds
   - "type" - the type of each synapse, symmetric or asymmetric
     - sym should be 0, asym should be 1
   - "volume" - the volume of each synapse being analyzed

3. Convert the data set to a text file by pressing "Save as..." and changing the format to txt.

4. Import the data set into R by opening R Studio and pressing "import dataset" in the upper right hand corner, then clicking "from text file..." finding your file and then pressing okay.

5. Get R ready to use your data set, and make sure it has all the right packages (formulas) for linear mixed effect regression analysis by typing in exactly this into R:

   ```r
   install.packages("lme4")
   install.packages("arm")
   install.packages("lmerTest")
   ``

   Your will only need to do this once on any computer.

6. Wait as the packages install. Once finished, type this into R (Replace [DATA FILE NAME] with the actual name of your data file. ex. synapsedata):

   ```r
   library("lme4")
   library("arm")
   library("lmerTest")
   attach([DATA FILE NAME])
   ```
7. To normalize the data, transform each synapse volume into log(volume) by typing this into R:

\[
\text{log.volume} = \log(\text{volume})
\]

8. Make sure your variables are nominal, not numerical; transform them by typing this into R:

\[
\text{group.transformed} \leftarrow \text{as.factor(group)}
\]

\[
\text{type.transformed} \leftarrow \text{as.factor(type)}
\]

8. Perform the regression analysis by typing this into R:

\[
\text{log.volume.model} = \text{lmer( log.volume} \sim \text{group.transformed} + (1 | \text{bird}) + \text{group.transformed*type.transformed} )
\]

This model is looking at the relationship between log.volume, the dependent measurement, and experimental group. It includes group and type as fixed effects, bird as a random effect (since the individual variations between birds in a group are random), and an interaction between group and type (since type may be dependent on group).

9. Now that the model has been made, view the results of the model by typing this into R:

\[
\text{display(log.volume.model)}
\]

Your can also type \text{summary(log.volume.model)} or just \text{log.volume.model} if you want the statistics displayed in a different way.

10. This should show the most relevant statistics, including the coefficients, their standard errors, and the fit of the model. Interpreting this output is a bit tricky, so I'll attempt to explain. But some background knowledge on linear regression is useful.

- First, the formula for the model you are displaying will be at the top, just as a reminder

- Beneath that, you will see the coefficients (coef.est) their standard errors (coef.se) for each factor and interaction, and the intercept

-- Each coefficient for group is comparing that group to the "base" group (group 1). The coefficient for logarithmic transformations is multiplicative, so a coefficient of 0.52 corresponds with a 52% increase compared to the base, while a negative coefficient indicates a decrease.
-- The type coefficients work the same way, comparing the type to the base type (type 0).

-- The interaction coefficients are more difficult to interpret, since they represent something a bit more complicated, but their coefficient interpretations are less important.

-- Standard errors indicate how precise the model's predictions are

Other useful functions

boxplot(bird) or boxplot(group+bird)

for getting means:

aggregate(volume, list(type,group), mean)

IMPORTANT: Remember that R is case sensitive.
Cited Works


